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Title: BIM MEP Model with Revit
1-Aims
Ability to develop a BIM MEP model, specifically in the plumbing system.

Ability to create isometric views and sheets using Revit software.

Ability to transmit information using BIM.
2 - Learning methodology

The teacher will give an explanation about the use of the tool.

Students will read this tutorial and watch the videos, do the exercise and explore the MEP tools and
environment.

To assess the achievement of the task, each student needs to create the Domestic Cold Water system and
the sheets designs.

3 - Tutorial duration

The task described in this tutorial will be carried out in a computer classroom.
It will last 6 teaching hours.

4 — Necessary teaching resources

Computer room with PCs with internet access.
Required software: Revit.

Hardware required: Computer with the capacity to support the software.

5—- Contents & tutorial
5.1 Introduction
5.2 Revit MEP Interface
5.3 Starting a Project

5.4 Link an Architectural Model
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5.5 Add Levels

5.6 Plumbing Systems
5.6.1 Plumbing Fixtures
5.6.2 Create the Domestic Cold Water System
5.6.3 Annotations
5.6.4 Create Schedules
5.6.5 Create Isometric Views
5.6.6 Create Sheets
6- Deliverables
A report of 3 pages showing the execution of the task.

7- What we have learned

How to link an architectural model in an MEP project.

How to place plumbing fixtures.

How to create a Domestic Cold Water system, with pipes and pipe fittings.

8 - Files to use in this tutorial

The project file created in the Revit Architecture tutorial in .rvt format.

5— Contents & tutorial

5.1 Introduction

Revit MEP is a part or functionality of Autodesk Revit software, for professionals who are working in three
engineering disciplines, Mechanical, Electrical, and Plumbing, in isolation or as part of a BIM project. Itis
a set of Revit tools that allow the elaboration of BIM models, used to streamline the engineering design
process, making the design and development of projects more efficient.

This tutorial is not intended to teach how to dimension plumbing and mechanical systems, but rather how
to use Revit main tools to model the systems using the software. It is an exercise in exploring the system,
which does not consider the rules for installing systems, which vary by country.
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In this tutorial, the Basic Families from the Revit library will be used. However, currently, several brands
that manufacture system components make their families available for downloading on their websites,
configured according to the dimensions, materials and other parameters found on the market, so that the

project is as close to reality as possible.

5.2 Revit MEP Interface

It is important to understand that Revit MEP is not software which is independent of Revit, but a
component part of it.

As in the Revit Architecture tutorial, it was already possible to become familiar with the work environment
and the navigation and editing tools. In the following video, some tools for specific use in MEP projects
will be demonstrated.

https://www.youtube.com/watch?v=m3V97Pxsdt4

5.3 Starting a Project

After opening the program, on the Revit home page, click on New, and the New Project window will open
to select the project template to be worked on. In this case, a pre-defined Revit template, Metric-Systems,
will be used.


https://www.youtube.com/watch?v=m3V97Pxsdt4
https://www.youtube.com/watch?v=m3V97Pxsdt4
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Revit MEP

MODELS

New Project XK

Template file

Imperial-Construction Template
c|Imperial-Architectural Template
Imperial-Structural Template
Imperial-Systems Template late
Metric-Construction Template
Metric-Architectural Template
Metric-Structural Template

T

[E Recent Files

B BIM360

Sample Architecture Proj...

Sample Structure Project

If the Metric-Systems Template does not appear in the options of the New Project window, click on
Browse to load this template. The Choose Template window will open, and in the English folder (Program
Data/Autodesk/RVT 2022/Templates/English), select the “Systems-Default_Metric” file, then click Open

to load it.

R Choose Template

Look in: |

==

My Computer
£

? X

English v| o= E‘} b 4 E'_“_ Views v
Nome - Data de modificacdo = Freview .
DefaultMetric 17/01/2020 15:40 !

DefaultUS-Canada 17/01/2020 15:40 !
[ﬂ Electrical-Default_Metric 17/01/2020 15:39 ! . =
[R] Electrical-DefaultGBRENU 19/01/2020 15:40 !
[B] LT_USM_Default 17/01/2020 15:42 !
Mechanical-Default_Metric 17/01/2020 15:40 ] .
Mechanical-DefaultGBRENU 19/01/2020 15:40 J
m Plumbing-Default_Metric 17/01/2020 15:42 }
[B] Plumbing-DefaultGBRENU 19/01/2020 15:40 !
Precast Detailing-DefaultMetric 17/01/2020 15:42 ]
Residential GBRENU 19/01/2020 15:39 J
[ﬂ Structural Analysis-DefaultGBRENU 19/01/2020 15:40 }
m Structural Analysis-DefaultMetric 17/01/2020 15:42 }
m Structural Analysis-DefaultMetric-Up 17/01/2020 15:42 !
Structural Analysis-DefaultUS-Canada 17/01/2020 15:42 ]
Systems-Default_Metric 17/01/2020 15:40 ]
[R] Systems-DefaultGBRENU 19/01/2020 15:40 !
m UK Pipe Template 19/01/2020 15:40 I
£

File name: | Systems-Default_Metric.rte \/|
Files of type: |Temp\ate Files (*.rte) o |

Open ‘ ‘ Cancel ‘

After loading the Template, select it in the New Project window and in Create New, select the Project

option.
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New Project X
Template file
Systems-Default_Metric.rte L
Create new
(@ Project () Project template
oK Cancel Help

After opening the Template, it is important to define the measurement units that will be used in the
project. To do so, click on the Manage tab, panel Settings and select the Project Units option.

u_ Project Parameters f‘é Transfer Project Standards
F]

s= Shared Parameters u_‘_':ﬂ Purge Unused

Q Global Parameters Project Units
Settings

Next, a window will open where the measurement units for each parameter are shown. We will change
the Length that will be changed to Meters, with two decimal places and Slope parameter too, which will
be changed to Percentage. For areas, volumes and angles, two decimal places in the Rounding option
should also be defined.

Project Units X
Discipline: Common L
Units Format (3
Angle 12.35°
lArea 1234.57 m*
Length | 123457 m
Mass Density 1234.57 kg/m®
Slope | 1235%
Speed 1234.6 km/h
Time 12346 s
Volume | 123457 m*®
Currency 123457
v

Decimal symbol/digit grouping:
123,456,789.00 A
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Format X
Use project settings
Units: Maters v
Rounding:
2 decimal places | | 0.01
Unit symbol:
m ~
[ Suppress trailing 0's
Suppress 0 feet
Show + for positive values
[Juse digit grouping
Suppress spaces

5.4 Link an Architectural Model

MEP projects are typically created using linked architectural models. The linkage allows working in a
collaborative and coordinated way between the architecture and MEP disciplines. If the linked model in
the project is modified, Revit will automatically update the model each time the project is opened.

In this tutorial, you will link the architectural model that was created earlier in the Revit Architecture
tutorial. To link, access the Insert tab and click on the Link Revit icon.

B®c) B O

Link | Link Link Link DWF
Revit| IFC CAD Topography Markup

A window then appears to select the file to be imported. Browse and search for the project file made in
the Revit Architecture tutorial, then select it. For Positioning, specify the desired option, in most cases
you should select “Auto — Internal Origin to Internal Origin”. Click on Open.
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? X

R Import/Link RVT
v| 4= [ X B Vews -

Look in: | [ Area de Trabalho
Preview

S Nome
Eﬁ @ OneDrive - Personal
History 2
S Este Computador ﬁ
=
m Bibliotecas
Documents ¥ Rede
e
My Computer
£ 7
i, m Architecture
—
My Netwo...
Favorites
File name: ‘ ~ ‘
Files of type: |RVT Files (*.nvt) |
B

Positioning: ‘Aulo - Internal Origin to Internal Origin

Cow 7] [ o

The linked model will then be displayed in the Drawing Area.

When the mouse cursor passes over the architectural model Link drawing, a blue selection box appears.

Sometimes these blue lines get in the way of the design visualization.
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To disable the selection of linked models, you must click on the Select Links icon in the Selection Toggles
bar so that the Selection Box no longer appears.

[F] & o 4 @ Po
5.5 Add Levels

The pre-defined template (Systems-Default_Metric) provides only 2 levels (Level 1 and Level 2), and
according to the needs of each project, it may be necessary to create more.

When opening one of the Elevations views from the Project Browser, it is possible to view the template
levels, and the levels of the imported model (Basement, Ground Floor and Roof) are also visible.

The levels of the linked architectural model are just a graphical representation and cannot be used as a
reference in the current project. All the elements of the linked model are in a single block, which makes it
impossible to change, so it is necessary to insert levels in the current project that overlap those of the
architectural model.

Roof S
6.00m
Level 2
_ 400m @

Ground Floor
260m G

Level 1 Basement G
0.00m @ 0.00m

It is recommended that Level 1 and Level 2 are renamed “Basement” and “Ground Floor”, respectively,
and that their heights be changed so that they are on top of the levels of the imported design (0.00 m and
2.60 m). A third level should be created and named “Roof”, with a height of 6.00 m.

To create this new level, for Roof, in the Architecture tab, Datum panel, click on Level.

oFf Grid

Datum
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When you approach the mouse cursor from the Ground Floor level, a temporary dimension will then
appear relative to the Ground Floor level, which serves as a preview of the level to be inserted. Depending
on the mouse movement, the dimension changes.

Ground Floor @
260m

Basement @
0.00 m

In relation to the Ground floor, the new floor will have 3.40 m. After viewing the temporary dimension of
3.40 m, just click on the drawing area and the new level will be inserted.

_ o _ _ o _ o o Roof G
6.00m

Ground Floor G
260m

Basement G
0.00m

In addition to creating a level for each story in a building, you can also create reference levels, such as sill
level.

5.6 Plumbing Systems

The domestic water system is divided into the following systems: Cold Water, Hot Water and Sanitary. In
this tutorial an example of creating a Domestic Cold Water system will be shown.

5.6.1 Plumbing Fixtures

Before starting to create a system, it is necessary to insert the plumbing fixtures, such as sinks,
waterclosets, bathtubs, and so on. Even though these elements have already been added to the
Architecture model, when the architecture is inserted through the Revit link, all its elements are in a single
block, which makes it impossible to change. Therefore, it is necessary to insert the family in the plumbing
project again, overlapping the architecture family.
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Therefore, in the Project Browser, open the “1- Plumbing” view, which corresponds to the Basement plant
(if necessary, it is possible to rename it). (image) In the Systems tab, Plumbing & Piping panel, click on the
Plumbing Fixture icon.

Project Browser - Projeto MEP X
£ 1O, Views (Discipline)
Electrical
Mechanical
= Plumbing
77
HVAC
= Plumbing
[=--Floor Plans
1 - Plumbing
2 - Plumbing
3D Views
Elevations (Building Elevation)
ﬁ Legends
T Schedules/Quantities (all)
Sheets (all)
917 ramilies
[Q] Groups
&8 Revit Links

On the Systems tab, Plumbing & Piping panel, click on the Plumbing Fixture icon.

D & = =
Pipe Pipe Parallel Plumbing Eprinkler
Placeholder Pipes 'I{h. Fixture v
Plumbing & Piping ]

In the Properties Palette, any device selected by Revit will appear. To change the selected equipment,
simply click on the image/description of the element.

Properties X
. M_Sink - Island - Single v
455 mmx455 mm - Public
New Plumbing Fixtures ~ Edit Type
Constraints 4
Schedule Level Level 1
Elevation from Level 0.0
Host <not associated -
Plumbing £
Flow Pressure 155158.000000 Pa
Mechanical a
System Classification Domestic Cold Water,Do..
System Type Undefined
System Name
System Abbreviation

Identity Data al
Properties help Apply

10
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The Type Selector will then open, where a list of several families of Revit equipment appears. Use the
scroll bar to see all available parts.

M_Sink - Island - Single
455 mmx455 mm - Public

| £DU INITE SUINED = DU 1 Uidin

250 mm Strainer - 80 mm Drain

250 mm Strainer - 100 mm Drain

. M_Sink - Island - Single

455 mmx455 mm - Private

| 455 mmtss mm - puiic

' M_Sink - Kitchen - Double

1065 mmx535 mm - Private

1065 mmx535 mm - Public

. M_Sink - Mop

710 mmx710 mm

‘ M_Urinal - Wall Hung

20 mm Flush Valve

25 mm Flush Valve
Q M_Water Closet - Flush Valve - Wall Mounted

Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf
Public - 8.1 Lpf

Public - Flushing Greater than 6.1 Lpf

For this example, none of the devices that initially appear in the Type Selector list will be used, as new
families will be loaded. To do this, after clicking on the Systems tab and the Plumbing Fixture icon, the
Modify |Place Plumbing Fixture tab will open, and so click on Load Family.

Manage Add-Ins  Modify | Place Plumbing Fixture

GIES &2 © @

Load | Model |[Place on| Place on Tag on
Family [in-place Face |Work Plane Placement

Maode Placement Tag

The Load Family window will open, in which the following path must be accessed:
ProgramData/Autodesk/RVT 2022/Libraries/English/Plumbing/MEP/Fixtures. Inside the Fixtures folder,
there are several folders named according to the type of equipment. Open the Water Closets folder.

11
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R Load Family ? %
Look in: | Fixtures v| o= -.+ x ._'_ Views -
Preview
r_ Nome Tipo
% Water Closets
Documents Urinals
Sinks
- Showe@
Lavatories
L e Emergency Fixtures
- Drinking Fountains
- Drains
My Netwo... Connectors
Bathtubs
‘ Appliances
Favorites
l File name: | v|
RRt LS Files of type: | All Supported Files (*.rfa, *.adsk) ~
Tools = | Open | ‘ Cancel |

When opening the Water Closets folder, some families of elements of this classification appear. Pressing
the CTRL key, select the families: “M_Water Closet — Flush Tank” and “M_Bidet”, and click Open to load

them into the project.

R Load Family ? X
Look in: | Water Closets - | 4= q X ._‘_ Views -
N Preview
ﬁlﬁ A | Nome Tipo
= m M_Water Closet - Quiet Flush Tank
History M_Water Closet - Flush Valve - Wall Mounted
m M_Water Closet - Flush Valve - Floor Mounted
Fﬁ M_Water Closet - Flush Tank i
[&) M_Bidet
Documents —-l
==
My Computer
£
My Netwo...
Favorites
File name: ‘ M_Water Closet - Flush Tank.rfa v|
v Files of type: ‘AII Supported Files (*.rfa, *.adsk) V|
| Open | | Cancel

Repeat the same process to load the following families:
e Sinks:
- M_Sink —Work
- M_Sink — Service
e Showers:
- M_Shower Stall — Rectangular
Note: In the Properties Palette, duplicate the element and create 4 new ones with the following dimensions:

12
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1.60mx1.00 m
1.30mx1.30m
1.45mx0.90 m
1.20m x0.90 m

e Lavatories:

- M_Lavatory - Rectangular
e Bathtubs:
- M_Bath Tub — Maestro
Note: In the Properties Palette, click on Edit Type and change the parameters Bath Tube Width to
1.10 m and Bath Tube Length to 2.50 m.
e Appliances:
- M_Washing Machine
- M_Dishwasher

After loading all the families, you can insert these elements into the view. In the Systems tab, Plumbing
& Piping panel, click on the Plumbing Fixture icon. Now in the Properties Palette, in the Type Selector, all
the loaded families appear. Select the “Private - 6.1 Lpf” type from the “M_Water Closed — Flush Tank”
family.

Properties X [H 2-Plumbing X

M_Water Closet - Flush Tank - J@
Private - 6.1 Lpf
Lies-:h el

25 mm Flush Valve

' M_Water Closet - Flush Tank

\ Private - 6.1 Lpf

Private - Flushing Greater than 6.1 Lpf M_Water Closet - Flush Tank
Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf

Q M_Water Closet - Flush Valve - Wall Mounted
Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf
Public - 6.1 Lpf

Public - Flushing Greater than 6.1 Lpf
‘ M_Whirlpool Spa
Mnct Rorontly | corl Tunoc

With the element selected, move the cursor to where you want to insert it. To rotate the object, you can

use the spacebar on the keyboard. When the object is positioned, just click on the drawing to insert it.

13
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SOOE:
Oup

80.0 mm

L%

3

15.0 mim
In

220/

When clicking on the inserted equipment, the Properties Palette identifies the object and customized
changes can be made according to each project. Next to the object, the identifications of the water inlet
and outlet connectors appear.

3.00 FU,
Out
80.0 mm

%

i,

15.0 mm

In

220 /U

Insert all other elements with the following distribution:

View: 1- Plumbing (Basement floor):

WC 1:
= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Llavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,60 m x 1,00 m - Private
WC 2:

= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Lavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,45 m x 0,90 m - Private

14
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View: 2 — Plumbing (Ground Floor)
- Bathroom 1:
= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Bidet
= M_Bath Tub — Maestro — Private
= M_Lavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,30 m x 1,30 m - Private
- Bathroom 2:
= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Llavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,60 m x 1,00 m - Private
- Bathroom 3:
= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Lavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,20 m x 0,90 m - Private
- Kitchen:
=  M_Sink —Work
= M_Dishwasher

= M_Water Closet — Flush Tank — Private 6.1 Lpf

= M_Llavatory — Rectangular — Private — 560 mmx560 mm
- Laundry Room:

= M_Sink — Service
- Storage:

=  M_Washing Machine

15
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KITCHEN

=

]
| [

|

pe= I T =

» Note: For the element “M_Sink - Work" it is necessary to edit the elevation in relation to the
floor. For this, select the element and in the Properties Palette, in the Elevation from level

field, fill in the value of 0.80 m.
Properties X

M_Sink - Work
510 mmx455 mm

Plumbing Fixtures (1) « | B3 Edit Type
Constraints Gl A~
Level Ground Floor
Elevation from Level 0.8000 m
Host Level : Ground Floar
Offset from Host 0.8000 m

Plumbing
Flow Pressure

Mechanical
System Classification

Properties help

5.6.2 Create the Domestic Cold Water System

After inserting all the fixtures, it is possible to start creating the Domestic Cold Water layout. To do so,
click on one of the inserted plumbing fixtures, and then on the Piping icon on the Modify tab.

16
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Modify | Plumbing Fixtures

2 | &5
Connect Piping
Into

1 Layout Create Systems

The Create Piping System window will appear, in which the Domestic Cold Water option must be selected
in System type. In the System name field, the name of the system can be changed (in this case it will be
kept), and the option Open System Editor must be checked. After these settings, click on OK.

Create Piping System ? x

System type: Domestic Cold Water ~

System name: | Domestic Cold Water 1

[~]open in System Editor

Select the Add to System tool to add other fixtures to the system.

] Gza =
y [E el @& v X
Modify |Properties Add Remove Select Finish Cancel
to System §from System = Equipment Editing System Editing System

Select = Properties Edit Piping System Mode

Move the mouse cursor closer and click on all the fixtures on the Basement and Ground Floor.

After selecting all the devices, click on Finish Edit System ¥ .

There are two ways to design the pipes: manually or through automatic solutions generated by Revit,
which can be changed after to insert.

To generate it automatically, just click on one of the elements that was added to the system and on the
Modify | Plumbing Fixtures, click on the Generate Layout icon.

17
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Modify | Plumbing Fixtures = Piping Systems

] - — '

+J Il (Lo

Generate] Generate Connect Piping
Layout JPlaceholder Into

1 Layout Create Systems

Revit will then read the elements that have been added to the system, and generate solutions from the
arrangement of these elements. The Generate Layout tab will open, where some editing tools appear.

E I'E)j Slope Value: Qf? X

Remove Place 0.0000% ¥ Finish Cancel
from System Base Layout Layout
Maodify Layout Slope Generate Layout
Generate Layout Solution Type  Network v 2of2 4l I Settings ...

In the Generate Layout bar, it is possible to select the solution type in Solution Type, which can be
Network, Perimeter or Intersection, according to the designer's preferences. In this example, the Network
option will be kept. Next to the solution type, there is the number of solutions generated by Revit. In this
case, two were generated.

Generate Layout Solution Type  Network ~ 2of2 4 Ik Settings ...

The design model usually establishes the elevations and types of pipes as well as their diameters.
However, it may be necessary to specify pipe types and standard elevations for system piping.

Clicking on Settings opens the Pipe Conversion Settings window. In the Main item, in the Pipe Type
parameter, select the material “PVC - DWV” and in Offset, define the value of -0.20m, for the pipes to
pass below the slab. For the Branch item, make the same changes.

Main |
Branch System Type: Domestic Cold Water
Setting Value
Pipe Type Pipe Types: PVC - DWV
Offset -0.2000 m
oK Cancel

One of the solutions generated by Revit was the one shown in the image below (Solution 1/2 of the
Network type). However, it is not the ideal solution, and it is necessary to make some adjustments. As it
is an automatically generated solution by the software, there may be differences from one computer to
another, and even more solutions.

18
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To edit the solution, click on Edit Layout.

Remove
stem from System

Modify Layout

With this tool it is possible to drag the inserted pipes and reposition them in the System. In this case, no
edits will be made, as adjustments can also be made manually outside the Layout editing.

The diameters of pipes and connections will also be changed later. By definition, all are 15mm in
diameter.

Click Finish Layout to complete.

v X

Finish Cancel
Layout Layout

Generate Layout

At the end, some errors may appear, one of which may be due to a connection that was left open as
shown in the following image.
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This element has an open connection. This may not be an error, but for flow
calculations to work correctly all connections should be sealed with an end cap.

The above error may be related to another error due to not having space to place accessories.
Warning: 3 out of 4

There was not enough room to place the required fittings. Consider increasing
the length of the segments, or moving them farther apart to generate a solution.

When showing error windows, the element is highlighted in the drawing for you to check. Now you must
proceed, because the errors will be corrected later.

Using the Project Browser, access the “2-Plumbing” floor plan corresponding to the Ground Floor. As the
System was inserted -0.20m below the slab of this floor, it will not be visible in this view. To make it visible,
in the Properties Palette, in the View Range parameter, click Edit.

Properties
E:l] Floor Plan 54
Floor Plan: 2 - Plumbing ~ Edit Type
Sun Path |:|
Underlay
Range: Base Level Basement
Range: Top Level Unbounded
Underlay Orientation Look down
Extents 2
Crop View ]
Crop Region Visible ]
Annotation Crop ]
| View Range Edit.
Associated Leve Ground Floor
Scope Box MNone
Depth Clipping No clip
Identity Data 2 v
Properties help Apply

The View Range window will then open. In View Depth, change the Level parameter to “Unlimited” and
then click OK.
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View Range

>

Primary Range

Top: Associated Level (Ground F Offset: | 4.0000 m
Cut plane: Associated Level (Ground F Offset: | 1.2000 m
Bottom: Associated Level (Ground F Offset: | 0.0000 m

View Depth

Level: Unlimited ~ Offset: | 0.0000 m
Learn more about view range

<< Show Apply Cancel

Therefore, the entire system is visible in the view from this floor.
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An important tip that helps to improve the visualization of the elements is to decrease the thickness of
the contour lines. To do this, click on the Thin Lines tool, located on the Quick Access Toolbar.

REOEzHG Q-7 a2-7f0A g-ofF]us--

Another tip that can help in graphic visualization is to set the Detail Level to the Fine option, and the Visual
Style to Realistic or Consistent Color.

[Elekx xme> o s <
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From the network layout automatically generated by Revit, manual edits will be made to better adapt it,
so that the pipelines are optimized. There is not only one design solution for this hydraulic system, so the
network layout varies according to work preferences.

As a demonstrative example, the system region shown in the image below will be edited. It is suggested
that the tracing of the other regions also be edited according to preferences.

— 0
o —— | \W |

V[
0

— [ A= —

To make your system settings easier to see, you can open elevation views in the Project Browse, and

create section views using the Sections tool > on the Quick Access Toolbar.

To begin with, the Bidet and Watercloset connections will be excluded in the Bathroom 1, as shown in the
following image. To delete an element, just click on it and press the delete key. Check in the 3D view that
all connections have been deleted.

a4
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A

To start tracing the network manually, select one of the elements and click on the

150 AU

“In” icon of the

equipment.

0
Out
1.00 FU

Then, a line that represents the piping path appears, which moves according to the movement of the

mouse cursor. Observe the temporary dimension and insert 0.10 m into the wall.

o
~f=)—

In the Systems tab, Plumbing & Piping panel, select the Pipe tool.

_ — ﬁ
Pipe Pipe Parallel ﬁ Plumbing Sprinkler
Placeholder Pipes EQ, Fixture

Plumbing & Piping

In the Properties Palette, verify that the “PVC — DWV” pipe type is selected.
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Properties X

Pipe Types -
PVC - DWV

‘Pipes ) v Edit Type
Constraints A oA

Horizontal Justification {Center

Vertical Justification Middle

Reference Level Basement

Top Elevation 24107 m

Middle Elevation 24000 m

Bottom Elevation 23893 m

Start Middle Elevation 24000 m
End Middle Elevation 24000 m

Slope 0.0000%
Dimensions A
Cutside Diameter 21.3 mm
Inside Diameter 15.8 mm
Size 15 mme e
Properties help Apply

In the options bar, check if the diameter of 15mm is selected.

Maodify | Pipes Diameter:| 15.0 mm w

With this, bring the mouse cursor closer to the end of one of the connections already inserted, and drag
to the other one, to connect the two objects.

[Boint. 15 mm @ 0.26 m

The pipe that goes under the toilet will also be deleted and a new one will be drawn with the Pipe tool so
that it lines up with the pipe at the other end.

You must select the pipe and delete it before creating the new one.
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From the 3D view, with the Visual Style in Realistic option, when approaching the mouse to the other end,
it is noticed that some connections remained with three outputs.

To remove one of the outputs, just click on the connection and then on the icon ™ . In this case, as it is
a short, straight link, the link will be completely removed.
Y g

15.0 mm

15.0 mm

15.0 mm O

It may also be necessary to add one more outlet in some connections, such as the connection that will

connect the new pipe to the toilet. To do this, click on the + icon in the desired direction.
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15.0 mm
In the Systems tab, select the Pipe tool and click on the new output created for the connection. In the
Options Bar, enter the value of -0.20 in Middle Elevation.

Middle Elevation:| -0.2000 m v| Apply

Drag the pipe from the connection outlet to the wall of the toilet connection, as shown in the following

=

images.

M

| Horizontal and Extension
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To align the pipes, just select one of them and in the Modify | Pipes select the Move tool w . Select the
point in the middle of the new pipe and then the middle point of the toilet pipe.

You must then select the connection and press the delete key.

To join the pipes, a very useful tool will be used to carry out these processes in Revit, which is the

-
Trim/Extend to Corner tool ' This tool can be used whenever it is necessary to connect pipes. To do
this, you must select one of the pipes and on the Modify | Pipe, select the Trim/Extend to Corner tool.

]
]

+
tglb

e D

s O[]

Dl

=

Modify

e i

oo
oo [

i EER"

With the tool selected, just click on the two pipes and the connection will be added automatically.
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The other equipment will also be connected in a more optimized way, such as the washbasins. This type
of washbasin has a diameter of 25 mm for the inlet of cold water. You must change this measurement by
clicking on the element and in the Properties Palette click on Edit Type.

Properties X

M_Lavatory - Rectangular
560 mmx560 mm - Private

Plumbing Fixtures (1) v| Edit Type
Constraints A A
Schedule Level Ground Floor

Elevation from Level 0.8650 m

Host Linked Revit Model : Praj...
Plumbing J

Flow Pressure 155158.000000 Pa ]
Mechanical &
System Classification Domestic Cold Water,Do...

System Type Domestic Cold Water
System Mame Domestic Cold Water
System Abbreviation

Identity Data %
Image

Comments v
Properties help Apply
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The type properties window will appear and the Cold Water Diameter parameter should be altered to 15
mm.

Type Properties X

Family: |M_la~atory - Rectangular . ‘ Load...
Type: |5M) mmx560 mm - Private v ‘ Duplicate...

Rename...

Type Parameters

~

Parameter ‘ Value ‘ =

Default Elevation 0.8650 m [
Sink Material <By Category> l
Faucet Material <By Category> D
Pimensions F
Sanitary Radius 16.0 mm ']
Sanitary Diameter 320 mm []
Sink Width 03810 m

Sink Length 0.3050 m

Lavatory Length 0.5600 m [
Lavatory Width 0.5600 m | ]
Hot Water Radius 7.5 mm []
Hot Water Diameter 15.0 mm

Cold Water Radius 7.5 mm

Cold Water Diameter 15.0 mm |]

<

What do these properties do?

I

In the same way as was done with the bidet and the toilet, the two sinks will be connected to optimize
the piping. Then the lavatory connections must be excluded and then new connections must be created

with the “In” tool S on the equipment.
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Using the tools mentioned above, connect the shower, bath, washbasins, bidet and toilet in a
configuration like the images below.

It is recommended to make similar changes in other parts of the system, so that better solutions are
created so that it is better distributed.

To assist in designing the system settings, you can open elevation views (Elevations) in the Project Browse,

and create section views using the Sections tool @ on the Quick Access Toolbar.

One of the possible solutions may look like the images below.
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With the Domestic Cold Water system already structured in the project, a pipe must be drawn to connect
the system with the point of the public network. In this project, the location of the public network point
is not represented, therefore, an approximation will be made.

The point at which the utility connection pipe will connect to the system is circled in Red in the image
below.
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To start designing the section connecting the public network, open the “2 — Plumbing” view,
corresponding to the Ground Floor.

In the Systems tab, Plumbing & Piping panel, select the Pipe tool.

N =2 b ¥

Pipe Pipe Parallel ﬁ Plumbing Sprinkler
Placeholder Pipes '13:}, Fixture

Plumbing & Piping El

In the Options Bar, change the Diameter parameter to 40mm and Middle Elevation to -0.40m.

Modify | Place Pipe Diameter: | 40.0 mm w Middle Elevation: | -0.4000 m v

In the floor plan, bring the mouse cursor closer to the area circled in red in the previous image and trace
a small stretch of pipe up to approximately half of the wall, as shown in the image below.

32



Co-funded by the
V ET3 Revit MEP Erasmus+ Programme
of the European Union

Delete the existing connection between the two pipes, click the end of the pipe horizontally and drag it to
meet the new 40mm pipe.

{I.ZULU m
_

A connection will be automatically created between the two pipes, with the diameter reducer (from 40
mm to 15 mm) coupled.

33



Co-funded by the Ry
V ET3 Revit MEP Erasmus+ Programme [
of the European Union

To reconnect the pipe in the vertical direction, click on it and drag it until it meets the pipe that was
previously connected.

The connections in this area should look like the image below.

You must now drag the pipe to the boundary of the terrain. To do this, open the 3D view and in the view
cube click on TOP, to view the drawing from above, as in a plan view. The difference is that in the 3D view
it is possible to visualize the boundaries of the terrain.

With this, click on the end of the 40mm pipe and drag it diagonally until it meets the boundary of the
terrain.

34



Co-funded by the
Erasmus+ Programme A

tBH MV ET3 Revit MEP of the European Union

|

* *

After extending the pipe, click on it to select it. On the Modify | Pipes, Edit panel, select the Cap Open
Ends option, to close the unconnected end of this pipe, as the connection to the public network is made

:ﬁ.l:l
Cap
Open Ends

by the local water company.

It should look like the image below.
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After structuring the entire network, some changes must be made to the diameters and connections in
some sections. In the image below, the sections that require a change in diameter are identified. The
green sections should be changed to 40mm and the yellow sections to 25mm. The others must be kept
with a diameter of 15 mm.
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The change is made in a very simple way. Just click on the pipe to be changed and in the Options Bar
(Modify Pipe) in the Diameter parameter, select the desired value (25mm or 40mm).

Itis very important to verify that when changing the pipe diameter, the connection diameter was changed
automatically. If it has not been changed, click on the connection and, in the Options Bar (Modify Pipe
Fittings) in the Diameter parameter, select the desired value (25mm or 40mm).

5.6.3 Annotations

To insert annotation elements, such as pipe diameter identifiers, access the Annotate tab, Tag panel, and

select the Tag by Category tool.
-
ﬂ@

Tag by
Category
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With the tool selected, move the mouse cursor closer to the element to be identified and the identification
text will appear, with the diameter corresponding to the element. Position the text as desired and click
on the element to insert the identification.

—— |
15 mMmg
\ L

In this case, the text is too large for the scale of the drawing. To change the text size, double click on the
text, and then the Modify | Label. Click once on the “Size” text to select it.

[Pipes : Pipe Types: PVC- DWV }—

‘ Size

With the text selected, in the Properties Palette click on Edit Type.

Properties X
Label -
23
Pipe Tags (1) v | 8 Edit Type
Graphics A oA
Sample Text Size...
Label | Edit...
Wrap between paramet...:[ ]
Horizontal Align Center
Vertical Align Middle
Keep Readable ]
Visible [ ]
. L
Properties help Apply

The Type Properties window will open, in which the Text Size parameter must be edited to 0,8 mm.
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Type Properties X
Family: System Family: Label & Load...
Type: EE b Duplicate...
Rename...

Type Parameters

Parameter ‘ Value ‘ :|
Graphics B
Color . Black
Line Weight 1
Background Opaque
Show Border O
Leader/Border Offset 2.0320 mm
Text A
Text Font Arial
Text Size 0.8000 iyl
Tab Size 12,5000 mm
Bold (]
Italic O
Underline O
Width Factor 1.000000

What do these properties do?

<< Preview Cancel Apply

After editing the text size, in the Family Editor panel, click on the Load into Project icon.

NE

Edit JLoad into Load into
Label § Project JProject and Close

Label Family Editor

A window will appear warning that the Family already exists. Click on the option “Overwrite the existing
version”.
Family Already Exists x
You are trying to load the family M_Pipe Size Tag, which
already exists in this project. What do you want to do?
—> Overwrite the existing version

—> Overwrite the existing version and its parameter
values

Cancelar

Click here to learn more

The text is now a more suitable size, if necessary, you can edit it again to make the text even larger or
smaller.
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To drag the text to the pipe that it represents, click on the *}* icon located just below the text, and drag it

to the desired location.

Carry out the same procedure for all the pipes, so that it looks like the following image.

15 mmea

ﬂ:15 mmg— 15 mme /JL

You can also use the Tag All tool, in the Annotate tab.

[ @

Tag by | Tag
Category| All

In the Tag All Not Tagged window, select the Pipe Tags option in the Category column.
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Tag All Not Tagged X

Select at least one Category and Tag or Symbaol Family to annotate
non-annotated objects:

(®) All objects in current view

Only selected objects in current view

|:| Include elements from linked files

Category Loaded Tags 2
[ [Mechanical Equipment Tags M_Mechanical Equipment Tag :
[ FNurse Call Device Tags M_Nurse Call Devices Tag
Pipe Tags M_Pipe Size Tag
[ ] Plumbing Fixture Tags M_Plumbing Fixture Tag : Boxe
[ fRoom Tags M_Room Tag : Room Tag
[ Security Device Tags M_Security Devices Tag
[ |Space Tags M_Space Tag : Space Tag
[ Sprinkler Tags M_Sprinklers Tag
[ Telephone Device Tags M_Telephone Device Tag
I =l Tance KA W2l Tam s 1P N
I:‘ Leader Leader Length: | 12.7 mm
Tag Orientation: | Horizontal e
oK Cancel Apply Help

By clicking OK, the identifications are added to all existing pipes in the project. However, many texts end
up overlapping and manual adjustments must be made anyway.

5.6.4 Create Schedules

Creating tables for Revit MEP is done in the same way as for Revit Architecture. What changes is the
information displayed in each type of table. As an example, a table will be created with information about
the pipes.

To start creating a table, in the Project Browser, in Schedules, right-click and then select the “New
Schedule/Quantities” option.
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New Schedule/Quantities...

Properties help Mew Graphical Column Schedule...
New Material Takeoff...

New Sheet List...

Project Browser - MEP automatit

=30 Views . Mew Mote Block...
3D Plumbin New View List
=) Elevations (Buil ew View LIst..
East - Plumi Browser Organization...
North - Pluy Search...
south - Plut by nd Al
West - Plum

=| Legends Collapse Selected

: Collapse All
Space Outdoor Air Schedule

Sheets (all)

91 Families

=-[@] Groups

Detail

Model

O

Then in the New Schedule window, under Category, select the Pipes option. In Name, you can change the
name of the table. In this case, Pipe Schedule will be kept.

New Schedule X
Category: Name:

MEP Fabrication Hange... A | Pipe Schedule
MEP Fabrication Pipew...

I';ﬂodel Groups (@) Schedule building components
arts

Pipe Accessories (O Schedule keys

Pipe Fittings

Pipe Insulations

Pipe Placeholders

Phase:
Piping Systems

Plumbing Fixtures

Rooms

RWT Links hd

New Construction b

In the Schedule Properties window, in the Fields tab, select the following parameters for the table:
Connection Type, Diameter, Flow, Length, Material, System Name, Top Elevation and Velocity.
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Schedule Properties X

Fields Filter ~Sorting/Grouping Formatting Appearance

Select available fields from:

Fipes et

Available fields: Scheduled fields (in order):
~| G [Connection Type
Assembly Code Diameter
Assembly Description Flow

Assembly Name + Length

Bottom Elevation Material
Comments System Name
Cost Top Elevation
Count Velocity

Critical Path

Description

Family

Family and Type

Fixture Units o

Flow State |j

Friction

Friction Factor Jx

fcGUID &

Image hd =

7% i R

[Jinclude elements in links

By clicking OK, the table will be created with all the information that was selected. If any changes are
made to the project, the table is automatically updated, and vice versa.
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<Pipe Schedule>
A B C 1] | E | F G H
Connection Type Diameter Flow Length Material System Name Top Elevation Velocity
Generic 15.0 mm 0.9L/s 0.38 m Polyvinyl Chloride - :Domestic Cold Water 10.22 m 4.8 mis
Generic 15.0 mm 0.0 Lis 385 m Polyvinyl Chloride - ;Domestic Cold Water -0.19 m 0.0 mis
Generic 15.0 mm 09Ll/s 0.03m Polyvinyl Chloride - :Domestic Cald Water (027 m 48 mis
Generic 15.0 mm 0.9Ls 1.03m Polyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 09Ll's 0.03m Pohyvinyl Chloride - iDomestic Cold Water (0.93 m 48 mis
Generic 15.0 mm 0.9Ls 1.03m Polyvinyl Chloride - :Domestic Cold Water (0.87 m 4.8 mis
Generic 15.0 mm 0.9L/s 0.03m Polyvinyl Chloride - :Domestic Cold Water :0.93 m 48 mis
Generic 15.0 mm 09LUs 0.04 m Polyvinyl Chloride - iDomestic Cold Water (048 m 48 mis
Generic 15.0 mm 0.9L/s 0.04 m Polyvinyl Chloride - :Domestic Cold Water :0.93 m 4.8 mis
Generic 15.0 mm 0.9Lis 1.03m Polyvinyl Chloride - ;Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 0.9L's 0.03m Polyvinyl Chloride - :Domestic Cold Water (0.93 m 4.8 mis
Generic 15.0 mm 0.9L/s 150 m Polyvinyl Chloride - :Domestic Cold Water :2.36 m 48 mis
Generic 15.0 mm 039 LUs 059 m Polyvinyl Chloride - {Domestic Cold Water (043 m 48 mis
Generic 15.0 mm 0.9L/s 0.03m Polyvinyl Chloride - :Domestic Cold Water (0.48 m 4.8 mis
Generic 15.0 mm 0.9Lis 1.03m Polyvinyl Chloride - ;Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 09Ll/s 0.03m Polyvinyl Chloride - :Domestic Cald Water (0.93 m 48 mis
Generic 40.0 mm 19Ll/s 14.02 m Polyvinyl Chloride - :Domestic Cold Water -0.18 m 1.5 mis
Generic 15.0 mm 09Ll's 0.06 m Pohyvinyl Chloride - iDomestic Cold Water (0.48 m 48 mis
Generic 15.0 mm 0.9Ls 0.07Tm Polyvinyl Chloride - :Domestic Cold Water (0.27T m 4.8 mis
Generic 15.0 mm 0.9L/s 0.04 m Polyvinyl Chloride - :Domestic Cold Water :0.82 m 48 mis
Generic 15.0 mm 09LUs 0.04 m Polyvinyl Chloride - iDomestic Cald Water (0.82 m 48 mis
Generic 15.0 mm 0.9L/s 1.76 m Polyvinyl Chloride - :Domestic Cold Water :0.82 m 4.8 mis
Generic 15.0 mm 0.9Lis 0.93m Polyvinyl Chloride - ;Domestic Cold Water 0.77 m 4.8 mis
Generic 15.0 mm 0.0L's 0.3Tm Polyvinyl Chloride - :Domestic Cold Water -0.19m 0.0 m/s
Generic 15.0 mm 0.0L/s 0.38m Polyvinyl Chloride - :Domestic Cold Water :0.22 m 0.0m/s
Generic 15.0 mm 039 LUs 015 m Polyvinyl Chloride - {Domestic Cold Water (043 m 48 mis
Generic 15.0 mm 0.0 L/s 3.04m Polyvinyl Chloride - :Domestic Cold Water 10.27 m 0.0 m/s
Generic 15.0 mm 0.0 Lis 0.49m Polyvinyl Chloride - ;Domestic Cold Water 0.27 m 0.0 mis
Generic 15.0 mm 09Ll/s 057 m Polyvinyl Chloride - :Domestic Cold Water (0.87 m 48 mis
Generic 15.0 mm 0.0L/s 0.38 m Pohyvinyl Chloride - :Domestic Cold Water :0.22 m 0.0 m's
Generic 15.0 mm 09Ll's 0.84 m Pohyvinyl Chloride - iDomestic Cold Water (0.27 m 48 mis
Generic 40.0 mm 0.0L's 677 m Polyvinyl Chloride - :Domestic Cold Water -0.38 m 0.0 m's

5.6.5 Create Isometric Views

For a better representation of the project, isometric views of the network can be created. To position the
drawing in an isometric view, just open the 3D view and click on one of the corners of the cube, as shown
in the blue area in the image below.

To create a general isometric view of the network, you must first duplicate the 3D view. To do this, in the
Project Browser, right-click on the 3D Plumbing view, then on Duplicate View and then on Duplicate.
Rename the view to “Isometric Plumbing”.
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w 3D View T

Open Sheet
3D View: 3D Plumbing Close
Graphics Show Camera
View Scale 1:10 Apply Template Properties...
\ .
scale Value 1: 100 Create View Template From View...
Detail Level Mediy . . :
Parts Visibility Show  DuplicateView : o T -
Visibility/Graphics Overr... Convert to mdepen#ent view Duplfcate with Detailing
Graphic Display Options Apply Depe;ndent Views... Duplicate as a Dependent
Discipline Plumt Save to Project as Image...
Show Hidden Lines  ByDie ~ Delete T
Properties help Engy g vea -
Rename... e ™ B
Project Browser - MEP automatici Select All Instances > 0( 7 -
- HVAC . L P
H v - - <
= Plumbing Al EdEs 0{‘:, ~
E| Floor Plans Save to New File... 95‘/
; 1- Plumbing Ferrlie
2- - Plumbing Expand Al
[=]- 3D Views

Collapse All
L] Elevations (Building Elevation)
- East - Plumbing
MNorth - Plumbing
South - Plumbing
West - Plumbing

Levels will not be needed in this view, so you can hide them. To do this, click on one of the levels with the
right mouse button, click on Hide in View and select the Category option.

Cancel

.

4

Repeat [Select links]
Recent Commands >

Drag End
Go to Floor Plan
Maximize 3D Extents

Hide in View > Elements
Override Graphics in View > Category

Create Similar By Filter...

Edit Family

Select Previous

Select All Instances >
Delete

With the isometry positioned according to the image below, the position will be fixed.

44



Co-funded by the

3 Revit MEP Erasmus+ Programme
of the European Union

To fix the position, in the visualization bar, just click on the @ Locked 3D View icon, and select the option
Save Orientation and Lock View. The view then cannot be rotated.

fg Save Orientation and Lock View

Restore Orientation and Lock View
Unlock View

F ik & R SRS ¢ Camn @re <

Itis important to define the cropping region of the view, so that when it is inserted into a sheet for printing,

=
it is already adjusted. To do this, click on 9 Show Crop Region on the visualization bar.
Hox xGafERe o s aE <

The rectangle with the clipping region will be displayed. Click on the rectangle and adjust it so that it is
very close to the limits of the drawing, as shown in the image below.
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After adjusting the cropping region, on the Preview Bar, select the L2 Hide Crop Region option to hide
the cropping region.

MFx & GaElE > o @&«

The general isometric view is created. Now an isometric view of a bathroom will be created. To do this,
duplicate the “Isometric Plumbing” view and rename it to “Isometric Plumbing Bathroom”.

e

With the “Isometric Plumbing Bathroom” view open, click on the
Unlock View option to allow the 3D view to be moved again.

,Unlock 3D View icon and select the

Save Orientation and Lock View

Restore Orientation and Lock View
’E‘ Unlock View
B x G o R Elitgh= ¢ o /s &

Rotate the 3D view through the corners of the visualization cube, until reaching the view as shown in the

following image. Once positioned, click on the i3 Locked 3D View icon again. The red circle represents
the environment for which the isometric view will be created.
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k>

To cut the isometric view only from the desired environment, you can use the Section Box tool. To enable
it, just check the Section Box option in the view's Properties Palette.
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Properties X
fta 3D View -
3D View: Isometric Plumbing ~ Edit Type
Scale Value 1: 100 ~
Detail Level Medium
Parts Visibility Show Qriginal
Visibility/Graphics Overr... Edit...
Graphic Display Options Edit...
Discipline Plumbing
Show Hidden Lines By Discipline
Default Analysis Display...None
Sub-Discipline Plumbing
Sun Path ]
Extents A
Crop View ]
Crop Region Visible ]
Annotation Crop ]
Far Clip Active ]
Far Clip Offset 304.8000 m
Scope Box Maone
Section Box
Camera 8
Rendering Settings Edit... B
Properties help . Appjy.

A Selection Box will then appear, which you can adjust to crop only the desired environment.
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b |
Note: If the Check Box is not visible, click on * , Reveal Hidden Elements in the visualization bar and

then it will appear.
[Reveal Hidden Elemens|

Using the arrows of the Selection Box, you must drag them or click in the direction in which you want to
move the Box limit, until you get a result similar to the image below.

To hide the Selection Box, right-click on it, click on Hide in View and select the Elements option.
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Cancel

Repeat [Hide Elements]

Recent Commands >

Hide in View > Elements
Override Graphics in View > Category
Create Similar Hy i
Edit Family

Select Previous

Select All Instances > B

Delete

Reset Crop Boundary to Model
Reset Crop Boundary to Screen
Find Referring Views

Zoom In Region

Zoom Out (2x)
Zoom To Fit

Previous Pan/Zoom
Next Pan/Zoom

h'4

Browsers >

~  Properties

The same can be done for the plumbing fixtures (sink, watercloset, shower) if you want only the pipes and
connections to appear in the isometric view, as in the image below.

5.6.6. Create Sheets

The creation of sheets for printing is done through exactly the same procedure described in the
architectural model tutorial (see item 5.11 of the Revit Architecture tutorial). In this case, following the
same instructions, you must create one or more sheets that contain the two plan views and the two
isometric views that were created in this tutorial.
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